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How to start an IconNMR set 

2 



IconNMR 
Select the respective holder 

2x 



IconNMR 
Select the disk 

• Base directory for data 
storage 

• Drop down list, can be 
edited. 

• Setup: IconNMR 
Configuration  User 

Manager (if no directory is 
entered in the configuration 
box the data will be stored 
under <topspinhome>/data) 
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IconNMR 
Disk options 

Resulting data path 
 
TopSpin < 3.0: 
C:\nmrdata\data\user\nmr\name 
 
 
TopSpin ≥ 3.0: 
 
 
 C:\nmrdata\user\name 
 
 
 
 C:\nmrdata\name 
   
 

IconNMR configuration: “Master Switches”: 
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IconNMR 
Name 

Configuration options: 
 
Free entry of “Name” for an user if 
 “Data Set Name Edit” is enabled. 
 
Pre-defined names can be defined in the  
User manager. 
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IconNMR 
Experiment Number 

The experiment number of the dataset 
 
Historical idea:  
Samples numbered with increment 10 
Experiments within each sample get 
increments of one. 
 
 
Configuration: 
General options: Experiment number 
Automatic Increment 
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IconNMR 
Solvent 

Solvent list will be created 
based on the information 
entered in TopSpin (edsolv / 
edlock). 
 

Additional Option: “Automation Window” 
  

Specify the most used solvent 
as default solvent 
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IconNMR 
Experiment 

This list will be defined in 
the User Manger. 
 
This list based on the 
parameter sets (available 
via “rpar”) in TopSpin 
or 
the “Composite 
Experiment” (marked with 
the leading “C”) in 
IconNMR. 
 

Additional Option: “Automation Window” 
  

Specify the most used 
experiment as default 
experiment 
. 
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IconNMR 
Priority 

Configuration:   many options. 
User dependent: 
Night-Time Experimente 
Global: 
„Priority on/off,  day/night“ 
Definition of night and weekend 
„Night time experiments during daytime when 
idle“ 
„First come/First served“ or … 

I want my sample measured a.s.a.p during 
daytime (sun)  

 
No hurry, please measure during nighttime 

(moon) 



11 

IconNMR 
Parameters 

A simple parameter editor. Each 
user can have his own set of 
parameters 

Change lock/shim/ATM parameters per 
sample. Should be enabled for the user 

Produce paper or environment-friendly 
Icon-nmr helps to protect the environment 
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IconNMR 
Parameters 

This tiny parameter editor is called 
in the configuration:  
User specific Parameters/Commands 

And look into the Parameters menu: 
of the setup window. 

So: execute arbitrary  
procedures on the dataset 
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IconNMR 
Parameters 

With the option: “Parameter Edit” switched on: 

eda / AcquPars tab 
 
edp /ProcPars tab 
 
ased 

Use “Return to IconNMR” to go 
back 
from the TopSpin Parameter 
editor 
to IconNMR 
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IconNMR 
Title/Orig 

Title / Originator Info  
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IconNMR 
Start time 

TopSpin ≥ 3.0: 
 
Start time for experiments 



IconNMR 
Set up experiment 



IconNMR 
Set up experiment 



A journey through IconNMR 
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A journey through IconNMR 
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• The development of IconNMR has been started 1995. 

• In 1996 the first customers starts working with IconNMR. 

• This course deals with new features in IconNMR (starting with TopSpin 3.0). 

Therefore this new features will be available for AVANCE II, AVANCE III, 

AVANCE III HD and Fourier 300 Spectrometer.  

• 49 new features. 



Where do I find information what‘s new in 
IconNMR? 

Where do I find information what‘s new in IconNMR? 

• „?“-button, hot key <Alt-h> or TopSpin-command docs   
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Where do I find information what‘s new in 
IconNMR? 

Where do I find information what‘s new in IconNMR? 

• „?“-button, hot key <Alt-h> or TopSpin-command docs    
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Where do I find information what‘s new in 
IconNMR? 
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A selection of new features in TopSpin 3.0 

TopSpin 3.0 

IconNMR 4.5 

• Start time may be set individually on experiments 

The time at which an experiment should start may be set. The system will modify the order of 

the run queue such that the experiment may be run at the set time. If it is not possible for the 

instrument to run the experiment at the time (due to another experiment already in progress or 

running at a set time with too long a duration), the setup table will show the time the 

experiment is expected to run. 

• Experiment Quotas 

Time quotas of experiments for users limiting total experiment time and maximum individual 

experiment time. Users can be allotted a maximum total time for their day or night experiments 

on a daily basis. Submission of individual experiments which exceed a maximum time will be 

prohibited. 

• Data set path now fully flexible 

For any standard Bruker data set path, the data/<user>/nmr may be completely/partially 

(only data & nmr) removed.  

• User Manager 

Users may be separated into groups for easier copying of settings to multiple users. 

23 

28 new features 



Start time for experiments 
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Start time for experiments 
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If another measurement is still running the acquisition will be started immediately 

after this measurement has been finished. 



Time limit 
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In the User Manager  a user-specific 

time limit can be defined. 

If there are to “many” 13C-NMR-measurements on your system… 

 Use 13C-NMR-experiments with S/N-option! 



IconNMR – time limit 
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If the permitted time exceeds the 

following message will appear. 



Data set managment 

TopSpin 3.0 

resulting data path: 

 

TopSpin < 3.0: 

C:\nmrdata\data\user\nmr\name 

 

TopSpin ≥ 3.0: 

 

 

 C:\nmrdata\user\name 

 

 

 

 C:\nmrdata\name 

   

 

IconNMR configuration: “Master Switches”: 

28 



Group names  
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Group names  
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User can be allocated 

convenient to groups. 



Group names   
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The user configuration is more 

convenient and quicken. 



Group names  
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Group names  
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Group names  
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  „jump to next sample“ 
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• jump-to-next-sample : 

• This option is now available via the IconNMR-configuration: 

 

 

TopSpin 3.0 



„jump to next sample“ 
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A selection of new features in TopSpin 3.1 

TopSpin 3.1 TopSpin 3.0 

IconNMR 4.6 
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12 new features 

• Automation window reads spreadsheets in .xls/.xlsx format with support for multiple 

workspaces. 

• Experiments may be submitted, cancelled with <Alt-s>, <Alt-c> etc. directly from the 

Sample Holder Overview window.  

• AssureTM - SST (System Suitability Test) 

This is now an integral part of IconNMR and includes acquisition and analysis of NMR 

standards for 1H line shape, 1H sensitivity, 13C sensitivity, 19F sensitivity, 31P sensitivity, and 

temperature calibration. This software automatically: 

 Validates the instrument performance for line shape and sensitivity 

 Performs temperature calibration and adjustment 

 Includes an automated ‘Stop’ criteria to prevent user standard acquisition upon 

specification failure 

 Generates a PDF report of all SST results. Tests are performed regularly at user defined 

intervals, requiring no instrument interaction and without interrupting Automation. 



ASSURE-SST 
System Suitability Test (SST) 

TopSpin 3.1 TopSpin 3.0 
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Automation window reads spreadsheets in 
.xls/.xlsx format 

TopSpin 3.1 TopSpin 3.0 

39 

Up to TopSpin 3.0 the “.CSV” format was:  

Save as “.CSV” file. 

Disk;Name;Solvent;Experiment;Sample ID;Plottitle 

C:\bruker\topspin3.0\examdata;test.001;CDCl3;PROTON;SAM000001;This is the title exp 1 

C:\bruker\topspin3.0\examdata;test.002;CDCl3;PROTON;SAM000002;This is the title exp 2 

C:\bruker\topspin3.0\examdata;test.003;CDCl3;C13CPD32;SAM000003;This is the title exp 3 

C:\bruker\topspin3.0\examdata;test.004;DMSO;C13DEPT45;SAM000004;This is the title exp 4 

 

Because of different language settings the “.CSV” file can consist different characters. 

The columns must be divided by semicolon!  



Automation window reads spreadsheets in 
.xls/.xlsx format 

TopSpin 3.1 TopSpin 3.0 
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Since TopSpin 3.1 a spreadsheet can be read in “.XLS/.XLSX” format. 

Save as 

“.XLS/.XLSX” 

Store this file in the folder <topspinhome>\prog\tmp (default location). 

 

 

 



Automation window reads spreadsheets in 
.xls/.xlsx format 

TopSpin 3.1 TopSpin 3.0 
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Automation window reads spreadsheets in 
.xls/.xlsx format 

TopSpin 3.1 TopSpin 3.0 
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Automation window reads spreadsheets in 
.xls/.xlsx format 

TopSpin 3.1 TopSpin 3.0 
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Automation window reads spreadsheets in 
.xls/.xlsx format 

TopSpin 3.1 TopSpin 3.0 
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Automation window reads spreadsheets in 
.xls/.xlsx format 

TopSpin 3.1 TopSpin 3.0 
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A selection of new features in TopSpin 3.2 

TopSpin 3.2 TopSpin 3.1 TopSpin 3.0 

IconNMR 4.7 
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9 new features 

• Additional Users 

IconNMR’s Additional user list may now be generated externally together with plain text  

passwords which the program encrypts on first display. 

 

 

Neu in TopSpin 3.2 pl5 (IconNMR 4.7.5):  

• ASSURE-SST: 

 Run SST every 0-365 days! (=> “0” means: Queued on demand.) 

  4 user defined experiments can be configured. 

• New in 3.2 PL4. Configure Automation to start without the Identify User Window.  

 



Password for Additional User 

• The user name are stored in: 

<topspinhome>/conf/instr/<spect>/inmrusers/.nmrusers 

as ASCII file. 

• The file format is very convenient and can be modified externally. Each user is 

entered in a new line with name, ID and Password (divided by colon): 

Max Musterman:mmu:<Encrypted Password> 

or 

Max Musterman:mmu:NULL 

if no password is entered. 
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TopSpin 3.2 TopSpin 3.1 TopSpin 3.0 



Password for Additional User 

• If the file will be created exteranlly, the respetive password can be entered plaintext. 

IconNMR will convert this plaintext password, when the  “Additional Users” 

configuration page will be opend for the first time after an IconNMR restart. 

• After that the configuration must be saved to renew the “.nmrusers” file. 

• The following format must be used for the plaintext password: 

Full Name:ID:PLAIN_TEXT_PASSWORD:Password 

 

• “Password” is here the example password to convert. 

• The key word 

“PLAIN_TEXT_PASSWORD” 

informs the software to convert 

the following term. 
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TopSpin 3.2 TopSpin 3.1 TopSpin 3.0 



Password for Additional User 
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Password for Additional User 
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New in TopSpin 3.2 pl5: 
Improved functionalities in ASSURE-SST  
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TopSpin 3.2 TopSpin 3.1 TopSpin 3.0 TopSpin 3.2pl5 



New in TopSpin 3.2 pl5: 
Improved functionalities in ASSURE-SST  
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TopSpin 3.2 TopSpin 3.1 TopSpin 3.0 TopSpin 3.2pl5 

• These test can be perormed 

in a range of 0 to 365 days. 

• 4 user defined experiments 

can be set up for SST. 

 



New in TopSpin 3.2 pl5: 
Improved functionalities in ASSURE-SST  
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TopSpin 3.2 TopSpin 3.1 TopSpin 3.0 TopSpin 3.2pl5 



New in TopSpin 3.2 pl5: 
Improved functionalities in ASSURE-SST  
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TopSpin 3.2 TopSpin 3.1 TopSpin 3.0 TopSpin 3.2pl5 

Please adapt these setting according to your system. 



New in TopSpin 3.2 pl5: 
Skip Identify User window 

Selecting this option will start the IconNMR set with the User ID of the logged-in 

operating system user. 
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A selection of new features in TopSpin 3.5 

TopSpin 3.5 TopSpin 3.2 … 

IconNMR 5.0 
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22 new features 

General Automation 

• Use system passwords to login to IconNMR's https site 

• Accounting reports may now be generated for users which are broken down according to the 

different settings of a particular originator item 

• Accounting report output now available in spreadsheet format 

• Pausing a run can remove or leave the sample in the magnet 

• Start times are copied/set automatically to/on follow up experiments 

• Absence of the Priority User permission no longer disables the day/night experiment switch 

• Spreadsheet files with .XLXS / .XLS / .CSV extensions can be imported automatically when 

copied to the external setup directory 

• Experiment numbers and parameter modifications can now be taken from spreadsheets 

• Send notification/data Emails in HTML with Authentication/Encryption 

• Easily define multiple data archiving directories 

• Configure Automation to start without User Identification. See Configuration Automation 

Window 

• Periodic Experiments Tool now makes full use of IconNMR's 'Start Time' system 



A selection of new features in TopSpin 3.5 

TopSpin 3.5 TopSpin 3.2 … 

IconNMR 5.0 
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22 new features 

Easy setup updated 

• See what experiments are available at a glance for even faster selection. 

• Limit the number/type of experiments to those you want to run, irrespective of  User Manager 

experiment lists 

 

Virtual Parameter Sets 

• Make new/Tweak experiments for use inside IconNMR Automation based on any TopSpin 

parameter set. 

• Parameters may be modified or even inherited by other experiments. Alternative/ multiple 

Acquisition AU programs/commands may be prescribed or alternative  underlying parameter 

sets selected. 

• Eliminate the need for multiple customized parameter sets (even across multiple instruments), 

with only minor differences. 

• See Configuration  Virtual Parameter Sets 



A selection of new features in TopSpin 3.5 

TopSpin 3.5 TopSpin 3.2 … 

IconNMR 5.0 
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22 new features 

Other New Features: 

• Export/Import All/Individual configuration settings (including user settings, composites etc.) with 

one XML file to other IconNMR installations. See the File menu in Configuration 

• Hidden Options from _iconnmrrc.txt are now fully accessible from the Options Resource File 

Settings Tab 

• Start and Stop the run via External Setup keywords START_RUN, STOP_RUN, also available 

as command line options (Type iconnmr ? in TopSpin for all options) 



A selection of new features in TopSpin 3.5 

TopSpin 3.5 TopSpin 3.2 … 

IconNMR 5.0 
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22 new features 

SampleJet Individual Sample MatrixID Support 

Scan a barcoded nmr tube into Icon's experiment setup table or easy setup window and place 

your sample anywhere. SampleJet will find it, and Icon will add the ID information to the data set 

ready for an ID based search for all your samples experiments* 

• Spreadsheet/External setup supported 

• SampleTrack/SampleJet supported 

• Integrated in IconNMR's Web interface 

 

InsightMR™ 

Monitor your reactions easily with this dedicated single interface, harnessing the full power of your 

Bruker NMR Instrument. Close down TopSpin and use the InsightMR shortcut on your Windows 

Desktop to launch the program. The shortcut icon is automatically placed on your desktop upon 

installation of the software. 

See the Quick Start guide, under the 'Help' menu of InsightMR, for details on how to use the 

program. 



A selection of new features in TopSpin 3.5 

TopSpin 3.5 TopSpin 3.2 … 

IconNMR 5.0 
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22 new features 

SmartDriveNMR 

Depending on a verification analysis by the CMC-assist algorithm, further measurements and 

interpretations may be triggered. Get the most out of your instrument by allowing it to decide what 

to measure. The ideal combination of NMR experiments for the verification task is identified and 

carried out. It is decided on-the-fly if further experiments can improve significantly the verification 

confidence while complying with the user's demands concerning allocatable spectrometer time 

and confidence. 

The relevant inputs are intuitive and NMR independent - only relating to the structure verification 

task Desired verification confidence, Maximum measurement time, Molecular structure and 

Solvent 

For more information consult your CMC documentation. 



Easy setup – easy 

Limit the automation to a dedicated number of experiments and solvents: 
e.g. for production control or Open-Access Systems: 
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TopSpin 3.2 TopSpin 3.1 TopSpin 3.0 TopSpin 3.5 



Easy setup – easy 

1. Select Name 
2. Select Solvent 
3. Select Experiment 
4. Enter the Title 
5. Queue Experiment  The System Administrator can arrange a 

customized help information. 
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TopSpin 3.2 TopSpin 3.1 TopSpin 3.0 TopSpin 3.5 



SampleJet /SampleXpress  
 Barcode Support 

IconNMR Setup can now handle Barcode 
– ID’s instead of Holder-Numbers!  
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TopSpin 3.2 TopSpin 3.1 TopSpin 3.0 TopSpin 3.5 
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Open Access! 
EASY Setup Mode –Barcode/Tube ID 

• Barcode/Tube ID based operation possible, too. 

• Enter Barcode ID/Tube ID of the respective NMR tube 

• Optional: Adaption of the automatically generated data set name 

• e.g. Username+“_“+Tube ID 

• Select Solvent and Experiment  

• „Queue experiment“  

 

 

 

 

 

 

 

 

 

• Place the sample on any (free) holder in the SampleChanger 

TopSpin 3.2 TopSpin 3.1 TopSpin 3.0 TopSpin 3.5 



Virtual Parameter Sets 

• Virtual Parameter Sets can be based on Bruker or customized  
Parameter sets 

• Parameter modification will be defined under “Command after dataset 
creation”. 
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TopSpin 3.2 TopSpin 3.1 TopSpin 3.0 TopSpin 3.5 



Virtuelle Parametersätze 

Carry over of parameters from the first to the next experiments 
e.g. to set up a series of experiments with the same RG or O1 values 
 
Commands for the acquisition (AUNM) 
 
 Blank: executes “xaua” 
 
 First experiment : XAUA;SAVEPARS rg o1 
 
 Next experiment:  GETPARS rg o1;XAUA 

In older IconNMR versions please use AU Programs: 
e.g. with saveprofpars/getprofpars 
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TopSpin 3.2 TopSpin 3.1 TopSpin 3.0 TopSpin 3.5 



IconNMR Configuration 

New option in IconNMR to import and export the configuration. 

IconNMR Configuration: 
File -> Export Configuration 

Generates a XML file including: 
• User Setting 
• Composite Experiments 
• Additional Users 
• Originators 
• Automation configuration 
• Virtual Parameter Sets 
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TopSpin 3.2 TopSpin 3.1 TopSpin 3.0 TopSpin 3.5 



IconNMR : E-mail 

Your IT Department requires a secured SMTP Server for sending e-mails: 
 
No problem for / with IconNMR! 
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TopSpin 3.2 TopSpin 3.1 TopSpin 3.0 TopSpin 3.5 
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Accounting in IconNMR 



Accounting 
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• IconNMR assists you by the accounting of the measurements. 

• This can be done user specific (“Additional-User“ or operating system user) or 

via Originator-infos.  



Accounting 
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• Example: Accounting per user 

(two possible options: “All“ or the respective user) 



Accounting 
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• Example: Accounting per user 



Accounting 
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• Example: Accounting per Originator-Item 



Accounting 
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• Example: Accounting per Originator-Item 
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Accounting in TopSpin 



Accounting in TopSpin 
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• Accounting in TopSpin has to be activated manually once. 

• . 



Accounting in TopSpin 
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• Accounting in TopSpin has to be activated manually once. 



Accounting in TopSpin 
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• The accounting file (a file per day; XML format) will be stored in the 

<topspinhome>/prog/curdir/acqhistory directory. 

• The accounting file can be opened via  

Manage  Spectrometer  Spectrometer Usage (account) 

 

 

 

 

 

• or the TopSpin command account 

 

     



Accounting in TopSpin 
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Accounting in TopSpin 
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Accounting in TopSpin 
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Accounting in TopSpin 

82 

• Using TopSpin-internal users you are able to account user-specfic. 
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Accounting in TopSpin 
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• Using TopSpin-internal users you are able to account user-specfic. 
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Accounting in TopSpin 

84 

• Switching the user can be executed with the commands “login“ / “logoff“. 
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Accounting in TopSpin 

85 85 



Accounting in TopSpin 

86 86 

• Accounting will not with multizg.  

• To use accounting for multiple experiments please use multicmd and set up the 

measurements with the spooler.  

• To use accounting in combination with AU Programs please insert instead of the 

term  

ZG  

the term 

XCMD(“sendgui zg”); 
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